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First steps with emacs 
Emacs is a powerful text editor and programming environment, available on 
the UNIX service. Its editor is considerably more powerful than the pico editor. 
This Guide provides an introduction to emacs. 
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Conventions: 

In this document, the following conventions are used: 
• A typewriter font is used for what you see on the screen. 
• A bold typewriter font is used to represent the actual characters you type at 

the keyboard. 
• A slanted typewriter font is used for items such as filenames which you should 

replace with particular instances. 
• A bold font is used to indicate named keys on the keyboard, for example, 

Esc and Enter, represent the keys marked Esc and Enter, respectively. 
• A bold font is also used where a technical term or command name is used in 

the text. 
• Where two keys are separated by a forward slash (as in Ctrl/B, for example), 

press and hold down the first key (Ctrl), tap the second (B), and then release 
the first key. 

 



 

Contents 

1 Introduction ........................................................................................................1 

2 Starting emacs ...................................................................................................1 

3 Exiting from emacs, and saving a file..............................................................1 

4 Basic editing commands...................................................................................2 
4.1 Some notation................................................................................................2 
4.2 Entering text...................................................................................................2 
4.3 Moving the cursor around a file......................................................................2 
4.4 Deleting text ...................................................................................................3 
4.5 Controlling word-wrap ....................................................................................3 
4.6 Aborting a command......................................................................................4 
4.7 Undoing changes ...........................................................................................4 
4.8 Inserting new text before existing text............................................................4 
4.9 Overwriting text ..............................................................................................4 
4.10 Inserting a new line ........................................................................................4 
4.11 Inserting a file.................................................................................................5 
4.12 Splitting a line.................................................................................................5 
4.13 Joining two lines.............................................................................................5 
4.14 Formatting text ...............................................................................................5 

5 Searching for and replacing text ......................................................................5 
5.1 Searching for some text .................................................................................5 
5.2 Replacing text ................................................................................................6 
5.3 Regular expressions ......................................................................................6 
5.4 Searching for text matching a regular expression..........................................7 
5.5 Using regular expressions when replacing text .............................................7 

6 Accessing emacs’ help system ........................................................................7 

7 Block editing using regions and rectangles ...................................................8 
7.1 Using regions .................................................................................................8 

7.1.1 Marking the start of a region of the text ..................................................8 
7.1.2 Deleting a region of text ..........................................................................9 
7.1.3 Cutting and pasting a region of text ........................................................9 
7.1.4 Copying and pasting a region of text ......................................................9 
7.1.5 Formatting the paragraphs in a region of text .........................................9 

7.2 Working with rectangles.................................................................................9 

8 Working with two windows .............................................................................10 

9 Executing UNIX commands from within emacs............................................10 
9.1 Spell-checking..............................................................................................10 
9.2 Printing.........................................................................................................11 
9.3 Expanding tab characters ............................................................................11 
9.4 Executing a UNIX command from within emacs...........................................11 
9.5 Using the current region as input to a UNIX command.................................11 

10 Miscellaneous topics.......................................................................................11 
10.1 Automatic completion of named commands ................................................11 
10.2 Horizontal scrolling.......................................................................................12 
10.3 Numeric arguments......................................................................................12 
10.4 Referring to non-printing characters ............................................................12 

Guide 21: First steps with emacs i



 

10.5 Backup files ................................................................................................. 12 
10.6 Line numbers ............................................................................................... 13 
10.7 Redrawing the screen.................................................................................. 13 
10.8 Using a larger font ....................................................................................... 13 

11 Customising emacs......................................................................................... 13 

12 Useful emacs commands................................................................................ 15 
12.1 Commands which have the same meaning in pico and emacs................... 15 
12.2 Commands in emacs which have a different meaning in pico..................... 15 
12.3 Other emacs commands.............................................................................. 15 

 

Guide 21: First steps with emacs ii 



 

1 Introduction 
Guide 17: An introduction to text editing using Pico  describes how Pico can 
be used to create and edit files. Although Pico is a simple text editor, it can 
be used for a large number of editing tasks. This Guide provides an 
introduction to emacs, a much more powerful program that allows you to 
perform a wide range of tasks including the editing of files.  

Note: Pico has only 21 editing commands, and about half of these have the 
same meaning in both Pico and emacs. The words as pico in the left hand 
margin indicate these commands. A table on the back page of this 
document lists the commands that have the same meaning in the two 
editors, and those emacs commands described in this document which 
have a different meaning in Pico. 

Sections 2 to 4 of this Guide introduce you to the basic facilities of emacs. 
You may also be interested in the searching and replacing commands 
described in section 5. The remaining sections of the Guide give some 
details about other facilities: these sections may be left to a second reading 
of the Guide.  

This Guide only hints at the power of emacs. There are many more facilities 
besides the ones described here. To prove it, there is a manual that is over 
350 pages long! This manual, the GNU Emacs Manual, is available on the 
shelves in Room CM131.  

as pico

2 Starting emacs 
If you want to edit a file that already exists, type: 

emacs filename 
where filename is the name of the file. 

If you want to create a new file, type: 
emacs newname 

where newname is the name you want to give to the new file. 

You will see a blank screen with a highlighted line at the bottom that says: 

--:--  newname 

3 Exiting from emacs, and saving a file 
If you want to leave emacs, press Ctrl/x followed by Ctrl/c. If you have 
made changes to a file, you will be asked: 

Save file /xxxx/yyyyy/zzz? (y or n) 

If you respond y, your changes will be saved and emacs will be exited. If 
you respond n, the changes will not be saved and emacs will ask: 

Modified buffers exist; exit anyway? (yes or no) 

Respond  
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yes  

(type the whole word) to exit. 

Another way of leaving emacs is to select Exit Emacs from the File menu. 

You can save the file being edited without leaving emacs either by pressing 
Ctrl/x followed by Ctrl/s or by selecting Save Buffer from the File menu. 

4 Basic editing commands 

4.1 Some notation 
Emacs uses the notation  

C-f  

to mean Ctrl/f, and the notation  

M-f  

to mean press the Esc key followed by the f key. 

4.2 Entering text 
In order to enter lines of text, just type the characters that you want. 

If you type a line that is longer than the width of the editing area, emacs will 
put a \ character in the right-most column, and then it will move to the start 
of the next line. Details of how you can get emacs to word-wrap are given 
in section 4.5. 

4.3 Moving the cursor around a file 
You should be able to move the cursor around the screen by pressing the 
left, right, down, and up cursor-moving keys. If they do not work, you can 
use the following keys instead: 

key    cursor movement 
as pico Ctrl/b   back one character 
as pico Ctrl/f   forward one character 
as pico Ctrl/n   next line (down one line) 
as pico Ctrl/p   previous line (up one line)  
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Besides the keys mentioned above, you can also use the following keys for 
moving the cursor: 

key(s)   cursor movement 
Ctrl/a  beginning of line as pico
Esc followed by m  first non-blank character of line 
Ctrl/e   end of line as pico
Esc followed by f  forward one word 
Esc followed by b backward one word 
Ctrl/v   forward one screen as pico
Esc followed by v  backward one screen 
Esc followed by < beginning of the file 
Esc followed by > end of the file 

Commands for searching for the occurrence of a piece of text in a file are 
given in sections 5.1 and 5.4. 

4.4 Deleting text 
You can use the following keys to delete text: 

Ctrl/d  deletes the character at the cursor 
Ctrl/k  deletes from cursor position to end of line 

Note:  in Pico, Ctrl/k deletes all the characters of a line. 

If you are entering text, and you want to remove the character that you 
have just typed, either press the Del key or move the cursor left and press 
Ctrl/d. 

If inadvertently you press Backspace or Ctrl/h, you may enter the help 
system of emacs. If this happens, the message  

C-h (Type ? for further options) 

will appear at the bottom of the screen. In order to get out of the help 
system, press Ctrl/g. (This key is emacs’ abort command.) 

as pico

4.5 Controlling word-wrap 
When you type a long line, you may want emacs to wrap automatically to 
the next line. To move to Fill mode, press Esc followed by x, type the 
characters  

auto-fill-mode  
and then press the Return (or Enter) key. You should see  

Fill 

appear at the bottom of the screen. (There are details in section 11 about 
how this can be done automatically each time you use emacs.) 

When dealing with long lines of data, you may need automatic line wrap 
turned off so that you can control where the ends of lines should be. If Fill 
mode is on, it can be turned off by typing Esc followed by x, type  

auto-fill-mode  
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and press Return. 

This command acts as a toggle (an on/off switch). If Fill mode (auto wrap) 
is on, this command will turn it off, and vice versa.  

Note: there are details of how you can avoid having to type all the 
characters of named commands such as auto-fill-mode in section 10.1. 

4.6 Aborting a command 
If you press the wrong key (and emacs get you into a dialogue with which 
you are unfamiliar), or if you wish to abort a command that requires more 
than one keystroke, press Ctrl/g. 

4.7 Undoing changes 
In order to undo the last change, press Ctrl/_ (i.e., press the Control, Shift 
and the underscore keys all at the same time), or press Ctrl/x followed by 
u. Consecutive uses of this command will undo previous changes.  

4.8 Inserting new text before existing text 
Move the cursor to the appropriate place and start typing. Any text to the 
right of the cursor will move over. 

4.9 Overwriting text 
You may want to overwrite existing text instead of inserting text. One way 
of doing this is to shift to the minor mode known as overwrite mode. To get 
into this mode, press Esc followed by x, type  

overwrite-mode  
and press Return. You should see  

Ovwrt 

appear at the bottom of the screen. (There are details in section 11 about 
how this can be done automatically each time you use emacs.) 

This command is also a toggle. So to get out of overwrite mode, press Esc 
x, type  

overwrite-mode  
and press Return. 

4.10 Inserting a new line 
Press Return at the end of a line to insert a new line after it. The cursor will 
move to the new line and you can start typing text. Alternatively, press 
Return at the beginning of a line to insert a new line before it. 
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4.11 Inserting a file 
A file can be inserted before the position of the cursor either by pressing 
Ctrl/x followed by i or by selecting Insert File from the File menu. Emacs 
will then display the name of the current directory and will wait for you to 
type in the name of the file to be inserted (followed by the Return key). If 
the file is in another directory, you will have to type in a pathname for the 
file. If necessary, remove the characters of the directory name that has 
been displayed by emacs, by moving the cursor to the left, and pressing 
Ctrl/d an appropriate number of times. 

Note: emacs uses the notation ~/ to refer to your home directory. 

4.12 Splitting a line 
Press Return at the appropriate column of a line in order to split it into two 
lines before that column. 

4.13 Joining two lines 
In order to join two lines, move to the first of the two lines, press Ctrl/e 
followed by Ctrl/d (followed by the Spacebar if it is required).  

4.14 Formatting text 
The lines of the current paragraph can be reformatted so that the lines do 
not extend past a predefined fill column by pressing Esc followed by q 
(anywhere within the paragraph). If the command is preceded by a numeric 
argument (see section 10.3), the text will also be right-justified. 

If you are using the .emacs file listed in section 11 (or have enabled text-
mode), you will be able to centre the current line by pressing Esc followed 
by s. The Esc s sequence can be preceded by a numeric argument 
indicating the number of lines that are to be centred. 

5 Searching for and replacing text 

5.1 Searching for some text 
Press Ctrl/s to indicate that you want to search for some text. Then type 
the text you want to search for. The search will start as soon as you type 
the first character. (Do not press Return after typing in the text.) 

For example, if you are searching for the word cat, as soon as you type c, 
emacs will find the first c and move the cursor after it. When you type a, the 
cursor moves to the first occurrence of ca. When you type t, the cursor 
moves to the first occurrence of cat. 

To search for the next occurrence of the same text, press Ctrl/s again. 
When you reach the end of the file emacs will beep and display  

Failing I-search 
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Press Ctrl/s again to search from the beginning of the file. 

To stop searching, press the Esc key. To search backwards in the file, use 
Ctrl/r instead of Ctrl/s. Note that emacs normally ignores the case of any 
letters when searching for text. 

5.2 Replacing text 
We now look at how to replace every occurrence of a string with some 
other text. If you want to replace all occurrences, you need the cursor to be 
at the beginning of the file before issuing the command. So, if necessary, 
first use Esc followed by < to move to the beginning of the file. Then press 
Esc followed by the % key. Now type in the characters of the text to be 
replaced and press Return. Then type the new text and press Return.  

At each occurrence of the search string, emacs will ask whether you want 
to replace the string. Press Ctrl/h for a list of possible replies. Examples 
are:  

reply  meaning 

y   change this one 
n   leave this one unchanged 
!   change all the rest without prompting 
q   abort the replace command 

5.3 Regular expressions 
There are some commands in emacs that understand a regular expression. 
This is a string that denotes a pattern. It uses characters that have special 
meanings. Some of the special characters that can be used are given 
below. 

. (full stop) Matches any single character except a newline. 
Example: l.ne matches line, lane, lone, and so on. 

*  Matches any number (0 or more) of occurrences of the 
previous character or regular expression. 
Example: a*b would match b, ab, aab, aaab, and so on. 

+  Matches one or more occurrences of the previous character 
or regular expression. 
Example: a+b would match ab, aab, aaab, and so on. 

[ ]  Encloses a set or range of characters to match.   
Examples: ca[rt] matches car or cat whereas ca[a-g] 
matches cab and cad, but not car or cat. 

^  If used at the start of a regular expression, matches the 
beginning of a line.   
Example: ^cat matches a line beginning with cat. 
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$  If used at the end of a regular expression, matches the end 
of a line.  
Example: cat$ matches a line ending with cat. 

5.4 Searching for text matching a regular expression 
You can tell emacs to search for text that matches a regular expression. 
This is done by pressing Esc followed by Ctrl/s followed by the regular 
expression. (Do not press the Return key.) A search using a regular 
expression can be repeated by pressing Ctrl/s to find the next occurrence, 
or Ctrl/r to find the previous occurrence. A search can be cancelled by 
pressing Esc. 

5.5 Using regular expressions when replacing text  
We now look at how to replace each occurrence of a string that matches a 
regular expression. If you want to replace all occurrences, you need the 
cursor to be at the beginning of the file before issuing the command. So, if 
necessary, first use Esc followed by < to move to the beginning of the file. 

Then either press Esc followed by x, type  

query-replace-regexp  

and press Return 

or select Query Replace Regexp from the Search menu. 

Now type in the characters of the regular expression and then press 
Return. Then type the new text and press Return. 

At each occurrence of a string that matches the regular expression, emacs 
will ask whether you want to replace the string. Press Ctrl/h for a list of 
possible replies. Examples are:  

reply  meaning 

y   change this one 
n   leave this one unchanged 
!   change all the rest without prompting 
q   abort the replace command 

6 Accessing emacs’ help system 
Emacs has a built-in help system. It can be entered by pressing Ctrl/h. You 
then need to press another key to execute one of the commands of the 
help system. If you press Ctrl/h again, you will get detailed information 
about the purpose of each of the help system's commands. We will only 
look at a few of the help system's commands here. 

Ctrl/h Ctrl/h emacs displays the purpose of each help 
command. 
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Ctrl/h a  You have to type in a string, and emacs then 
gives  you a list of commands that contain that 
string.  
Example: if you then type in  
search  
and press Return, emacs would display a list of 
the searching commands. 

Ctrl/h k  You have to type in a sequence of keys, and 
emacs then lists the command associated with 
the sequence.  
Example: if you then press Ctrl/x followed by 
Ctrl/s, emacs says that this command saves the 
current buffer. 

Ctrl/h i  This command executes the info system. The 
GNU Emacs Manual is stored as a tree of 
information which can be traversed using this 
command. Pressing h after Ctrl/h i gives you 
help on the info system. 

Ctrl/h t  This command gives a tutorial on emacs. If you 
want  to leave the tutorial (and emacs) at any 
stage, press Ctrl/x followed by Ctrl/c, and type y 
at the prompt. 

These commands can also be found on the Help menu. 

7 Block editing using regions and rectangles 
You can edit blocks of text with emacs either by defining a region of text 
(which is the text between any two positions in the file), or by defining a 
rectangle (which is a block of text delineated by specific columns and lines). 

7.1 Using regions 

7.1.1 Marking the start of a region of the text 
All the commands in section 7.1 involve defining a region of text. This is 
done by setting a mark at one end of the chunk and moving the cursor to 
the other end.  

To set a mark, first move the cursor to the position to be marked, and then 
press either Ctrl/Spacebar (or Ctrl/Shift/2 (press and hold Ctrl and Shift, 
press 2, release all keys together) if Ctrl/Spacebar does not work). Look 
for  

Mark set 

at the bottom of the screen which confirms that the mark has been set. 
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7.1.2 Deleting a region of text 
Set a mark at the start of the region to be deleted. Move the cursor to the 
end of the region of text (one character after the last character to be 
deleted). Press Ctrl/w to delete the region. 

7.1.3 Cutting and pasting a region of text 
Delete the region of text as just described. Then move the cursor to 
wherever the text is to be inserted. Press Ctrl/y to paste the text before the 
new location.  

7.1.4 Copying and pasting a region of text 
Set a mark at the start of the region to be copied. Move the cursor to the 
end of the region to be copied (one character after the last character to be 
copied). Press Esc followed by w to copy the region without deleting it. 
Move the cursor to where the text is to be inserted. Press Ctrl/y to paste 
the text before the new location.  

7.1.5 Formatting the paragraphs in a region of text 
All the paragraphs in a region can be reformatted by typing Esc followed by 
g. If the command is preceded by a numeric argument (see section 10.3), 
the text will also be right-justified. 

You can indent all the lines of a region by a particular number of columns 
by using a numeric argument to the command Ctrl/x followed by Tab. For 
example, the combination Ctrl/u 3 Ctrl/x Tab will indent each line of the 
current region by three spaces. Similarly, Ctrl/u - 3 Ctrl/x Tab removes 
three spaces from the start of each line. 

7.2 Working with rectangles 
A rectangle is one or more columns of text in one or morelines. Commands 
are available to delete rectangles, fill them with spaces, or cut and paste 
them.  

To delineate a rectangle for a command to work on, set a mark in the 
firstline, to the left of the first column (i.e., the top left of the rectangle). 
Move the cursor to the last row, then to the right of the last column (i.e. the 
bottom right of the rectangle). 

To delete the rectangle, press Esc followed by x, type  
delete-rectangle 

and press Return. 

To cut a rectangle, press Esc followed by x, type  
kill-rectangle 

and press Return. 
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To paste a killed rectangle in a new location, move the cursor to wherever 
the rectangle is to go and press Esc followed by x, type  

yank-rectangle 
and press Return. 

To replace the contents of a rectangle with spaces, press Esc followed by 
x, type  

clear-rectangle 
and press Return. 

To fill the area of a rectangle with spaces and push the original rectangle to 
the right, press Esc followed by x, type  

open-rectangle 
and press Return. 

8 Working with two windows 
It is possible to split the current window into two halves, and thereby create 
two separate windows in which you can edit two files. Here are some 
commands for working with two windows. 

Ctrl/x followed by 2 Split the window in two, each containing a 
copy of the file being edited. You can edit 
different parts of the same file 
simultaneously. This command is also 
available by selecting Split Window from 
the Files menu. 

Ctrl/x followed by o  Move to the other window. 

Ctrl/x followed by Ctrl/f  Load a different file into the current 
window. 

Ctrl/x followed by 0  Remove the current window. 

Ctrl/x followed by 1  Remove the other window. This command 
is also available by selecting One Window 
from the Files menu. 

9 Executing UNIX commands from within emacs 

9.1 Spell-checking 
You can spell-check the file being edited by pressing Esc followed by x, 
type 

spell-buffer 
and press Return. 
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9.2 Printing 
If you are using emacs from UNIX, you must have informed UNIX of which 
printer you want to use. You can do this by typing the following UNIX 
command before you start emacs: 

setenv LPDEST printername  

Within emacs, you can then print the file being edited by pressing Esc 
followed by x, type  

lpr-buffer  
and press Return. 

9.3 Expanding tab characters 
You can expand any tab characters in the current region into spaces by 
pressing Esc followed by x, type  

untabify  
and press Return. 

9.4 Executing a UNIX command from within emacs 
A UNIX command can be executed from within emacs by pressing Esc 
followed by the ! key. The output from the UNIX command will appear in a 
separate window — see section 8. If the Esc ! command is preceded by a 
numeric argument, the output from the UNIX command is inserted into the 
file being edited. 

9.5 Using the current region as input to a UNIX command 
The current region can be passed as input to a UNIX command by pressing 
Esc followed by the | key. The output from the UNIX command will appear 
in a separate window — see section 8. If the Esc | command is preceded 
by a numeric argument, the text of the current region is replaced by the 
output from the UNIX command. 

10 Miscellaneous topics 

10.1 Automatic completion of named commands 
If you press Esc followed by x, you will then have to type in the characters 
of a command name. Instead, it is possible to type the first few characters 
of the command name and then press Tab. If the portion that you have 
typed uniquely identifies a particular command, emacs will fill in the rest of 
the command for you. If it does not, then emacs completes the command 
only as far as it is unique: you will then have to type further characters. If 
you want to see a list of possible completions, press Tab again.  
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10.2 Horizontal scrolling 
When working with long lines, you may scroll right one screen by pressing 
Ctrl/x followed by the > character. Scroll left one screen by pressing Ctrl/x 
followed by the < character. A $ appears in the last column of a line when 
there is text to the right which is not displayed on the screen, and a $ 
appears in the first column when text to the left is not displayed.  

10.3 Numeric arguments 
Any emacs command can be given a numeric argument. Most commands 
interpret the argument as a repetition. For example, giving the Ctrl/f 
(forward one character) command an argument of 8, moves forward by 8 
characters. 

The easiest way to set a numeric argument is to press Ctrl/u followed by 
the digits of the number. This numeric argument will be applied to the next 
emacs command you issue. For example: Ctrl/u followed by 8 followed by 
Ctrl/f will move forward 8 characters. Negative arguments may be used. 
Often they make a command move or act backwards. Type a hyphen (a 
minus sign) before the first digit to indicate a negative argument. 

Some commands just use a numeric argument as a way of indicating a 
different flavour of the same command. In these cases, the command just 
needs to be preceded by Ctrl/u. 

10.4 Referring to non-printing characters 
Normally, control characters and the ESC character are interpreted as 
commands by emacs. There may be a situation where you want to refer to 
a character that is a control character or the ESC character. For example, 
you may want to insert one of these characters into the text. This can be 
done by preceding the character with Ctrl/q. Any (8-bit) character can be 
entered by typing Ctrl/q followed by the three octal digits of the internal 
code of the character. 

For example, to insert the character with internal code 255 (which is 377 in 
octal), press Ctrl/q and type  

377 
Emacs will then insert \377 into the text at the current cursor location to 
indicate that a character with this internal code appears at this point. 

10.5 Backup files 
By default, at the start of an editing session, emacs creates a copy of the 
file being edited. If you are editing prog.f, the file prog.f~ will be used for 
the backup file. The backup file is not altered if, during the course of an 
editing session, you use Ctrl/x followed by Ctrl/s in order to save the latest 
version of the file being edited.  

Details of how you can customise emacs so that it never creates backup 
files are given in section 11. 
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10.6 Line numbers 
You can move to line n of a file by pressing Esc followed by x, type  

goto-line  
and press Return. Emacs will then ask you to type in a line number. 

You can find out the line number of the line containing the cursor by 
pressing Esc followed by x, type  

what-line  
and press Return. 

10.7 Redrawing the screen 
The screen will be re-drawn if you press Ctrl/l (Ctrl and the letter l). 

10.8 Using a larger font 
If you are using the X windows system, the size of the font used for the 
characters of the display can be controlled by using the following resource: 

emacs*font:9x15 

This line could be included in the .Xdefaults file in your home directory. 

11 Customising emacs 
At the start of its execution, emacs reads the contents of a file called 
.emacs (if there is one) in your home directory. This file can be used to 
customise your use of emacs.  

You may find it useful to put some or all of the following commands in this 
file. The lines beginning with a group of 3 semi-colons (;;;) are comment 
lines. 

as pico
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;;; use text-mode rather than fundamental mode as its major mode  
;;; this is needed by some of the following commands 
(setq default-major-mode 'text-mode) 
;;; turn on the minor mode called Fill mode (word wrap) whenever 
;;; it enters text-mode 
(setq text-mode-hook 'turn-on-auto-fill) 
;;; set the fill-column to 70 --- this happens to be the default 
(setq-default fill-column 70) 
;;; do not to make any backup files 
(setq make-backup-files nil) 
;;; turn on auto-fill and overwrite whenever it enters text-mode 
(setq text-mode-hook  
    '(lambda () (auto-fill-mode 1) (overwrite-mode 1) )) 
;;; turn on auto-fill whenever it enters text-mode (method 1) 
(setq text-mode-hook  
    '(lambda () (auto-fill-mode 1) )) 
;;; turn on auto-fill whenever it enters text-mode (method 2) 
(setq text-mode-hook 'turn-on-auto-fill)  
;;; display the time and notify of incoming mail 
(display-time) 
;;; display the date and time and notify of incoming mail 
(setq display-time-day-and-date t) 
(display-time) 
;;; bind Ctrl/x followed by ? to the what-line function 
(global-set-key "\C-x?" 'what-line) 
;;; bind Ctrl/x followed by _ to the goto-line function 
(global-set-key "\C-x_" 'goto-line) 

The above text is included in the file /users/examples/emacs/emacs.sug. 

If you edit files that contain programs, you may find it useful to use the 
following line in your .emacs file: 

(global-font-lock-mode t) 

This command configures emacs to use colour to highlight the symbols of 
your program. The above text is in the file 
/users/examples/emacs/emacs.fontlock. 

The file /users/examples/emacs/emacs.java contains other commands 
that Java (or C++) programmers may find useful. 
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12 Useful emacs commands 

12.1 Commands which have the same meaning in pico and emacs 
Key press(es) meaning 
Ctrl/b  move cursor back one character 
Ctrl/f  move cursor forward one character 
Ctrl/n  move cursor to next line (down one line) 
Ctrl/p  move cursor to previous line (up one line)  
Ctrl/a move cursor to beginning of line 
Ctrl/e  move cursor to end of line 
Ctrl/v  move cursor forward one screen 
Ctrl/d  deletes the character at the cursor 
Ctrl/l redraw the screen 

12.2 Commands in emacs which have a different meaning in pico 
Key press(es) meaning 
Ctrl/x Ctrl/s save the file being edited without leaving emacs 
Ctrl/x Ctrl/c leave emacs 
Ctrl/k  deletes from the cursor position to the end of line 
Ctrl/g abort a command that requires more than one 

keystroke 
Ctrl/s initiate a forwards search 
Ctrl/r initiate a backwards search 
Ctrl/u n enter numeric argument (n) 
Ctrl/w delete a region 
Ctrl/y paste deleted text 
Ctrl/q nnn enter octal code (nnn) of any 8-bit character. 

12.3 Other emacs commands 
Key press(es) meaning 
Esc followed by m  move cursor to first non-blank character of line 
Esc followed by f  move cursor forward one word 
Esc followed by b move cursor backward one word 
Esc followed by v  move cursor backward one screen 
Esc followed by < move cursor to beginning of the file 
Esc followed by > move cursor to end of the file 
Esc followed by % replace text 
Esc followed by q format current paragraph 
Ctrl/Shift/_ (or Ctrl/x u) undo a change 
Ctrl/h enter emacs’ help system 
Ctrl/Spacebar  set a mark to delineate a region 
(or Ctrl/Shift/2) 
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